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About this User Guide

Revision History The table below displays the revision history for the chapters in this user 
guide.

This user guide provides getting started information about the Altera 
Stratix II GX PCI Express development board. 

How to Contact 
Altera

For the most up-to-date information about Altera products, go to the 
Altera world-wide web site at www.altera.com. For technical support on 
this product, go to www.altera.com/mysupport. For additional 
information about Altera products, consult the sources shown below.

Chapter Date Version Changes Made

All July 2006 1.0.0 First publication

All August 2006 1.0.1 Minor edits to flow and kit contents to reflect production version

All April 2007 1.0.2 Added warning not to use external power supply when the Altera® 
Stratix® II GX PCI Express development board is powered from the host 
computer chassis

Information Type USA & Canada All Other Locations

Technical support www.altera.com/mysupport/ www.altera.com/mysupport/ 

(800) 800-EPLD (3753)
(7:00 a.m. to 5:00 p.m. Pacific Time)

+1 408-544-8767
7:00 a.m. to 5:00 p.m. (GMT -8:00) 
Pacific Time

Product literature www.altera.com www.altera.com 

Altera literature services literature@altera.com literature@altera.com 

Non-technical customer 
service

(800) 767-3753 + 1 408-544-7000
7:00 a.m. to 5:00 p.m. (GMT -8:00) 
Pacific Time

FTP site ftp.altera.com ftp.altera.com 
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Typographic Conventions Stratix II GX EP2GX90 Signal Integrity Development Board Reference Manual

Typographic 
Conventions

This document uses the typographic conventions shown below.

Visual Cue Meaning

Bold Type with Initial 
Capital Letters 

Command names, dialog box titles, checkbox options, and dialog box options are 
shown in bold, initial capital letters. Example: Save As dialog box. 

bold type External timing parameters, directory names, project names, disk drive names, 
filenames, filename extensions, and software utility names are shown in bold 
type. Examples: fMAX, \qdesigns directory, d: drive, chiptrip.gdf file.

Italic Type with Initial Capital 
Letters 

Document titles are shown in italic type with initial capital letters. Example: AN 75: 
High-Speed Board Design.

Italic type Internal timing parameters and variables are shown in italic type. 
Examples: tPIA, n + 1.

Variable names are enclosed in angle brackets (< >) and shown in italic type. 
Example: <file name>, <project name>.pof file. 

Initial Capital Letters Keyboard keys and menu names are shown with initial capital letters. Examples: 
Delete key, the Options menu. 

“Subheading Title” References to sections within a document and titles of on-line help topics are 
shown in quotation marks. Example: “Typographic Conventions.”

Courier type Signal and port names are shown in lowercase Courier type. Examples: data1, 
tdi, input. Active-low signals are denoted by suffix n, e.g., resetn.

Anything that must be typed exactly as it appears is shown in Courier type. For 
example: c:\qdesigns\tutorial\chiptrip.gdf. Also, sections of an 
actual file, such as a Report File, references to parts of files (e.g., the AHDL 
keyword SUBDESIGN), as well as logic function names (e.g., TRI) are shown in 
Courier. 

1., 2., 3., and
a., b., c., etc.

Numbered steps are used in a list of items when the sequence of the items is 
important, such as the steps listed in a procedure. 

■ ● • Bullets are used in a list of items when the sequence of the items is not important. 

v The checkmark indicates a procedure that consists of one step only.

1 The hand points to information that requires special attention. 

c
The caution indicates required information that needs special consideration and 
understanding and should be read prior to starting or continuing with the 
procedure or process.

w The warning indicates information that should be read prior to starting or 
continuing the procedure or processes

r The angled arrow indicates you should press the Enter key.

f The feet direct you to more information on a particular topic. 
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1. About This Kit

Introduction The PCI Express (PCIe) Development Kit, Stratix® II GX Edition provides 
everything you need to develop and test a complete PCIe system based 
on the Stratix II GX device. 

This chapter briefly describes the kit’s features and documentation 
including:

■ The Stratix II GX PCI Express development board
■ Quartus® II Software, Development Kit Edition (DKE) 
■ Reference design
■ MegaCore® IP Library CD-ROM

Kit Features The PCI Express Development Kit, Stratix II GX Edition features:

■ The Stratix II GX PCI Express Development Board—a prototyping 
platform that allows you to develop and prototype high-speed bus 
interfaces as well as evaluate Stratix II GX transceiver performance. 

f For specific information about board components and interfaces, refer to 
the Stratix II GX PCI Express Development Board Reference Manual.

■ Reference Design—The reference design is useful for a variety of 
hardware applications and lets you quickly begin board prototyping 
and device verification. 

■ PCI Express Development Kit Application & Drivers—The kit’s 
application and drivers allow you to process memory read and write 
transactions to the board. In addition, you can initiate memory or 
DMA transaction pairs (read and write), as well as read the various 
configuration and DMA registers.

■ Quartus II Software, Development Kit Edition (DKE)—The Quartus II 
software provides a comprehensive environment for system-on-a-
programmable-chip (SOPC) design. The Quartus II software 
integrates into nearly any design environment, with interfaces to 
industry-standard EDA tools. The kit includes:
● The SOPC Builder system development tool
● A one-year Quartus II software license, Windows platform only
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Documentation

1 The Quartus II DKE software license allows you to use the 
product for 12 months. After 12 months, you must purchase 
a renewal subscription to continue using the software. For 
more information, refer to the Altera® website at 
www.altera.com.

■ MegaCore IP Library CD-ROM, version 6.0—This CD-ROM contains 
Altera IP MegaCore functions. You can evaluate the MegaCore 
functions using the OpenCore® Plus feature, which allows you to do 
the following:
● Simulate the behavior of a MegaCore function within your 

system
● Verify the functionality of your design, as well as quickly and 

easily evaluate its size and speed
● Generate time-limited device programming files for designs that 

include MegaCore functions
● Program a device and verify your design in hardware

You only need to purchase a license for a MegaCore function when you 
are completely satisfied with its functionality and performance, and want 
to take your design to production.

1 The OpenCore Plus hardware evaluation feature is an 
evaluation tool for prototyping only. You must purchase a 
license to use an Altera IP function in production designs.

Documentation The PCI Express Development Kit, Stratix II GX Edition contains the 
following documents:

■ Readme file—Contains special instructions and points to the kit’s 
documentation. 

■ PCI Express Development Kit, Stratix II GX Edition Getting Started User 
Guide—Describes how to start using the kit (this document). 

■ Stratix II GX PCI Express Development Board Reference Manual—
Provides specific information about the board’s components and 
interfaces, steps for using the board, and pin-outs and signal 
specifications.
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2. Getting Started

Introduction The PCI Express (PCIe) Development Kit, Stratix® II GX Edition is a 
complete PCIe prototyping and testing kit based on the 
Stratix II GX device. With this kit, you can perform device qualification 
testing, memory read and write transactions to the board, read the 
various configuration and direct memory access (DMA) registers, and 
use the example design’s DMA engine to write to system memory. 

In addition to providing a PCIe development board, the kit also includes 
all of the hardware and software development tools, as well as the 
documentation and accessories you need to begin developing PCIe 
systems using the Stratix II GX device.

This user guide will familiarize you with the contents of the kit and walk 
you through setting up a PCIe development environment.

In this guide, you will do the following:

■ Inspect the contents of the kit
■ Install the development tools software
■ Set up licensing
■ Use the kit’s demo application and example design to: 

● Configure the on-board Stratix II GX device 
● Perform memory read and write transactions on the board
● Read configuration and DMA registers

Before You 
Begin

Before using the kit or installing the software, be sure to check the kit’s 
contents and inspect the board to verify that you received all of the items 
listed in this section. If any of the items are missing, contact Altera® before 
you proceed. You should also verify that your computer’s hardware and 
software meet the kit’s system requirements.
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Before You Begin

Check the Kit’s Contents

The PCI Express Development Kit, Stratix II GX Edition (ordering code: 
DK-PCIE-2SGX90N) contains the following items:

■ Stratix II GX PCI Express development board with an 
EP2SGX90FF40C3NES Stratix II GX device 

■ PCI Express Development Kit, Stratix II GX Edition CD-ROM, version 
1.0.0, which includes:
● PCI Express example design
● PCI Express development kit application and device drivers

■ One-year license of Quartus® II Software Development Kit Edition 
(DKE), Windows only platform

■ MegaCore® IP Library CD-ROM
■ USB-Blaster™ download cable 
■ Power supply and adapters for North America, Europe, the United 

Kingdom, and Japan
■ Heatsink/fan combination and board standoff hardware
■ Complete documentation

● PCI Express Development Kit, Stratix II GX Edition Getting Started 
User Guide (this document)

● Stratix II GX PCI Express Development Board Reference 
Manual

■ Schematic and board design files

Inspect the Board

Place the board on an anti-static surface and inspect it to ensure that it has 
not been damaged during shipment. Verify that all components are on the 
board and appear intact.

1 In typical applications with the PCI Express development board, 
a heatsink is not necessary. However under extreme conditions 
the board may require the use of additional cooling to stay 
within operating temperature guidelines. Power consumption 
and thermal modeling should be done to determine whether 
additional cooling is necessary. In the event that it is, a 
heatsink/fan combination has been provided for your 
convenience.

w Without proper anti-static handling, the Stratix II GX PCI 
Express development board can be damaged.

Downloaded from Elcodis.com electronic components distributor 

http://elcodis.com/parts/5654681/DK-PCIE-2SGX90N-PROMO.html


Altera Corporation Getting Started User Guide 2–3
August 2006 PCI Express Development Kit, Stratix II GX Edtion

Getting Started

Figure 2–1 shows the Stratix II GX PCI Express development board.

Figure 2–1. Stratix II GX PCI Express Development Board

f Refer to the Stratix II GX PCI Express Development Board Reference Manual 
(available on the PCI Express Development Kit, Stratix II GX Edition 
CD-ROM) for information on the board’s components.

Hardware Requirements

To run the demo application design, a single computer with a x8 PCIe slot 
is required. However, for more flexibility in downloading applications to 
the Stratix II GX PCI Express development board, a second computer 
with the Quartus II software is required as the programming host.

All of the other hardware that you need to use the board is provided with 
the PCI Express Development Kit, Stratix II GX Edition.
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Power Supply
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Downloaded from Elcodis.com electronic components distributor 

http://elcodis.com/parts/5654681/DK-PCIE-2SGX90N-PROMO.html


2–4 Getting Started User Guide Altera Corporation
PCI Express Development Kit, Stratix II GX Edtion August 2006

Before You Begin

Software Requirements

To use the kit’s demo application, you must be running Windows XP.

Install the following software before you begin developing designs for 
the kit:

■ The Quartus II software version 6.0. See “Installing the Quartus II 
Software and MegaCore Functions” on page 2–6.

■ Internet Explorer 4.01 with Service Pack 2 or later to use Quartus II 
Help. You need a web browser to register the Quartus II software and 
request license files.

1 For the latest Quartus II software updates, please check the 
Altera website, www.altera.com.

To license the Quartus II software, you will need: 

■ Your network identification card (NIC) ID.
■ The kit’s serial number, which is adhered to both the outside of the 

development kit’s box and the CD-ROM.

1 Your NIC ID is a 12-digit hexadecimal number that identifies 
your computer. Networked (or floating-node) licensing requires 
a NIC ID or server host ID. When obtaining a license file for 
network licensing, you should use the NIC ID from the 
computer that will issue the Quartus II licenses to distributed 
users over a network. You can find the NIC ID for your card by 
typing "ipconfig /all" at a command prompt. Your NIC ID 
is the number on the physical address line, without the dashes.

Quartus II System Requirements

To use the PCI Express Development Kit, Stratix II GX Edition CD-ROM 
with the Quartus II software provided with the kit, your system must 
meet the Quartus II software minimum requirements. 

f For system requirements, refer to the Quartus II Installation & Licensing 
for PCs at www.altera.com.
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Getting Started

Software 
Installation

The instructions in this section explain how to install the following:

■ PCI Express Development Kit, Stratix II GX Edition CD-ROM
■ PCI Express Development Kit, Stratix II GX Edition demo 

application and drivers
■ The Quartus II Software, Development Kit Edition, including 

MegaCore functions from the MegaCore IP Library CD-ROM

Installing the PCI Express Development Kit, Stratix II GX Edition 
CD-ROM Contents

The PCI Express Development Kit, Stratix II GX Edition CD-ROM contains 
the following items:

■ PCI Express Development Kit, Stratix II GX Edition GUI application 
and drivers

■ Example design programming files
■ PCI Express Development Kit, Stratix II GX Edition Getting Started User 

Guide (this document)
■ Stratix II GX EP2SGX90 PCI Express Development Board Reference 

Manual

To install the PCI Express Development Kit, Stratix II GX Edition CD-ROM, 
perform the following steps:

1. Insert the PCI Express Development Kit, Stratix II GX Edition CD-ROM 
into your CD-ROM drive. 

2. Double click the SIIGX_PCIe_Kit-v1.0.0 file. 

1 The CD-ROM should start an auto-install process. If it does not, 
browse to the CD-ROM drive and double click on the setup.exe 
file.

3. Follow the online instructions to complete the installation process. 

The installation program copies the PCI Express Development Kit, 
Stratix II GX Edition files to your hard-disk, installs the software drivers 
and application, and creates an icon in Programs > Altera > Stratix II GX 
PCI Express Kit v1.0.0 (Windows Start menu), which you can use to 
launch the Windows development kit GUI. 

When the installation is complete, the PCI Express Development Kit, 
Stratix II GX Edition installation program creates the directory structure 
shown in Figure 2–2, where <path> is the PCI Express Development Kit, 
Stratix II GX Edition installation directory.
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Software Installation

Figure 2–2. PCI Express Development Kit Installed Directory Structure 

Table 2–1 lists the file directory names and a description of their 
contents.

Installing the Quartus II Software and MegaCore Functions

Refer to Installing the Quartus II Software in the Quartus II Installation & 
Licensing Manual for PCs for software installation instructions. After 
installing the software, request and install a license to enable it. 

f For information on obtaining a license file, refer to “Licensing 
Considerations”.

To use the Quartus II software included with the kit, you must first obtain 
a license file. A one-year Quartus II DKE software license is included with 
the kit. 

1 During the installation of the Quartus II software, you are given 
the option to install the MegaCore IP Library. When prompted 
to do so, choose to install the MegaCore IP Library and follow 
the on-screen instructions.

<path>

SIIGX_PCIe_ Kit-v1.0.0

 The default Windows installation directory is C:\Altera\kits.

Docs

Drivers

Examples

BoardDesignFiles

Table 2–1. Installed File Directory Names and Description of Contents

Directory Name Description of Contents

BoardDesignFiles Contains the board design and production test files. You can use the board design 
files as a starting point for creating your own prototype board.

Docs Contains the documentation related to the development kit.

Drivers Contains the install.bat file, which installs the demo application’s driver files and the 
pcie.exe file.

Examples Contains the example design files for the PCI Express Development Kit, Stratix II GX 
Edition. 
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Licensing 
Considerations

Before using the Quartus II software, you must request a license file from 
the Altera web site at www.altera.com/licensing and install it on your 
computer. When you request a license file, Altera emails you a license.dat 
file that enables the software.

To obtain a license, perform the following steps.

1. Point your web browser to the Altera web site at 
www.altera.com/licensing.

2. In the Development Kit Licensing list, select Licensing for RoHS 
Compliant Development Kits. 

3. Follow the on-line instructions to request your license. A license file 
is emailed to you.

1 Before installing your license, close the following software 
if it is running on your computer:

● The Quartus II software
● The MAX+PLUS® II software
● The LeonardoSpectrum™ synthesis tool
● The Synplify software
● The ModelSim® simulator
● The Precision RTL Synthesis Software

4. To install your license, refer to Specifying the License File in the 
Quartus II Installation & Licensing Manual for PCs, which is included 
with the kit.

Using the
Kit’s Demo 
Application
and Example 
Design File

The kit provides an example design file and an easy-to-use demo 
application with a custom graphical user interface (GUI). The demo 
application’s GUI allows you to: 

■ Specify endpoint (PCIe x8 MegaCore function) DMA read, write, and 
loop commands 

■ Specify memory read/write and loop commands
■ Read various configuration and DMA registers 

In this section, you will: 

■ Install the demo application drivers and PCI Express development 
board

■ Perform memory read and write transactions on the board
■ Read configuration and DMA registers
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Using the Kit’s Demo Application and Example Design File

1 The Stratix II GX PCI Express development board ships with a 
pre-installed example design. For instructions on downloading 
the example design directly to the board, refer to Appendix A, 
Downloading Programming Files to the Development Board. 

Data Flow Block Diagram 

Figure 2–3 shows a block diagram of the data flow from the x8 PCIe edge 
connector through the Stratix II GX device block, which includes the 
application layer, Altera PCIe x8 MegaCore function, and the Quartus II 
software alt2gxb megafunction.

The kit’s demo application allows for memory read and write 
transactions to the development board. In addition, the kit’s example 
design (SIIGX_PCIe_Example_Design.sof) has a DMA engine that 
allows the development board to write to system memory. 

Figure 2–3. Stratix II GX Device Block 

Stratix II GX Device

x8 PCIe Edge 
Connector

Altera PCIe 
x8 MegaCore 

Function

 Application Layer

Target 
Memory

DMA
Engine

Target 
Memory
Control

DMA
 Registers Quartus II Software

alt2gxb Megafunction
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Install Drivers and PCI Express Development Board

As stated in the “Hardware Requirements” on page 2–3, for a flexible 
setup that allows you to download different programming files to the 
on-board Stratix II GX device, you need two computers. Specify 
computer #1 as the development board host computer, and computer #2 
as the Quartus II programming host computer.

f This section discusses the example design and the development board 
host computer (computer #1). For information on using the Quartus II 
programming host computer (computer #2), refer to Appendix A, 
Downloading Programming Files to the Development Board.

To install the demo application drivers and PCI Express development 
board, use the following steps:

1 To install the drivers, you need to have administrator privileges 
on your computer. 

From computer #1:

1. Install the PCI Express Development Kit, Stratix II GX Edition 
CD-ROM.

2. Open the Drivers directory, and double-click the install.bat file. 

3. After the install.bat file is finished copying files and installing the 
drivers, shutdown computer #1.

4. Insert the PCI Express development board in a x8 PCIe slot.

Finish Installing the Drivers and the Development Board, Run 
the Demo Application

In this section, you will finish installing the demo application drivers and 
the PCI Express development board; then run the demo application.

1 If you want to download a programming file that is different 
than the kit’s pre-installed example design file, refer to 
Appendix A, Downloading Programming Files to the 
Development Board.

1. Start computer #1.

2. The Windows XP Found New Hardware Wizard appears. See 
Figure 2–4.
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Using the Kit’s Demo Application and Example Design File

Figure 2–4. Found New Hardware Wizard Window

3. Click Next.

4. The Hardware Installation window appears (Figure 2–5). 

Figure 2–5. Hardware Installation Window

5. Click Continue Anyway.

6. Click Finish in the Completing the Found New Hardware Wizard 
window to finish installing the drivers. 
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7. To execute the demo application’s GUI, run the kit’s demo 
application from the shortcut, Start >Altera > PCI Express 
Development Kit, Stratix II GX Edition v1.0.0, or execute the 
pcie.exe file found in the <path>\SIIGX_PCIe_ Kit-v1.0.0 
\SII_GX_PCIe_Example_Design\Drivers directory. 

1 If you receive an “Application Error” message when 
launching the demo application, please install version 1.1 or 
later versions of the .NET framework. Some Windows versions 
do not have runtime DLL for the .NET application. The .NET 
framework application can be downloaded from the following 
location: 
http://www.microsoft.com/downloads/details.aspx?FamilyId
=262D25E3-F589-4842-8157-034D1E7CF3A3&displaylang=en

8. Configure the parameters in the Altera PCI Express Demo Kit 
Application window as shown in Figure 2–6:

● Under Commands, turn on EP DMA Loop.
● Under Address/Size:

• Type 0x0000000 in the Address Offset box.
• Type 2048 in the Transfer Length box.
• Type 1000 in the Iterations box.
• Select Random Packet in the Data Type list.

9. Click Execute. The following message appears, 

“***SUCCESS***”.

f The demo kit application can be configured to perform other tests 
including memory read and write transactions on the board, loop read 
and write transactions, and also read the various configuration and 
DMA registers. For more information about performing other tests, refer 
to the PCI Express-to-DDR2 SDRAM Reference Design Application Note.
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Figure 2–6. Altera PCI Express Demo Kit Application Window
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Appendix A. Downloading
Programming Files to the

Development Board

Introduction The Stratix® II GX PCI Express development board is shipped 
pre-programmed with the factory example design; however, you may 
want to download your own design. This section discusses how to 
download other design files.

w This document assumes that the development board is 
connected to a computer using a PCIe x8 slot. An external power 
supply and cables have been provided so that you can use the 
development board without connecting it to a PCIe chassis. 

WARNING: DO NOT CONNECT THE EXTERNAL POWER 
SUPPLY TO THE PCIe BOARD IF IT IS BEING POWERED 
FROM A BACKPLANE PCIe x8 SLOT.

To use the external power supply, connect the power cable to the 
board and plug the other end into a power outlet, then place the 
power switch (SW1) in the ON position. When power is 
supplied to the board, the LED (D19) illuminates. If the board 
does not power up after you connect the power cable, ensure 
that the power switch (SW1) is in the ON position.

Connect the 
USB-Blaster 
Cable to the 
Board 

An Altera® USB-Blaster™ cable is provided with the kit. Connect the 
USB-Blaster cable’s 10-pin female plug to the Stratix II GX device’s JTAG 
header on the Stratix II GX EP2SGX90 PCI Express development board 
(U10), and connect the other end to the USB port on the computer running 
the Quartus® II software. 

This approach allows you to directly configure the Stratix II GX device 
using an SRAM Object File (.sof). The kit’s reference design includes a 
SOF for directly configuring the Stratix II GX device.

When connecting the JTAG side of the USB-Blaster cable, connect the 
marker line on the cable to pin 1 of the header (J5). Pin 1 of J5 is numbered 
on the board.
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f The USB-Blaster download cable driver must be installed before the 
USB-Blaster download cable can be used. For information about 
installing the USB-Blaster download cable driver included with the 
Quartus II software, refer to the USB-Blaster Download Cable User Guide. 
The driver files are installed at <quartus-install-dir> 
\drivers\usb-blaster.

Download 
Example Design 
SOF and View 
State Machine 
Status

To program the on-board FPGA with the example design file and view 
the state machine status via the Quartus II software’s SignalTap® II Logic 
Analyzer, use the following steps:

1. Start the Quartus II software.

2. On the Tools menu, click SignalTap II Logic Analyzer.

3. From the File menu, browse to the <path>\SIIGX_PCIe_ Kit-v1.0.0 
\Examples\SII_GX_PCIe_Example_Design directory and open 
the PCIe SignalTap II file, SIIGX_PCIe_Example_Design.stp.

4. From the same directory as the SignalTap II file, download the PCIe 
SOF file, SIIGX_PCIe_Example_Design.sof.

After the board powers up, the on-board flash memory—which ships 
pre-programmed with the factory design—automatically configures the 
Stratix II GX device. The CONF DONE LED illuminates, signaling that 
the Stratix II GX device is configured.

In Figure A–1 the SignalTap II Logic Analyzer displays the status of the 
ltssm state machine 0x0F, which indicates that the x8 PCIe MegaCore® 
function is in the L0 state. 

f For more information about the SignalTap II Logic Analyzer included 
with the Quartus II software, refer to the Design Debugging Using the 
SignalTap II Logic Analyzer chapter in volume 3 of the Quartus II 
Handbook. 
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Figure A–1. Quartus II Software SignalTap II Window
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